
Twenty-five years ago or so, a single editing station could cost more
than $250,000. Today you can get real editing power for free with
programs like Windows Movie Maker and Apple’s iMovie. The award-
winning documentary “Tarnation,” for example, which is kind of like a
90-minute videoblog, was edited entirely in iMovie and was the first
such movie to gain theatrical distribution.

Whether you’re editing a feature film or a vlog, the basic principle of
editing holds true: You want to choose the best shots to tell your story
or convey your concept, then arrange them in an order that holds
meaning for you. In this chapter, we cover the editing process as it
relates particularly to vlogging, no matter what your story is or what
application you use. You can find step-by-step instructions for using
iMovie or Movie Maker in their built-in Help tools, various online
resources, and books like Peachpit’s Visual QuickStart and Visual

5

Editing for Vlogs

             



Chapter 5: Editing for Vlogs

QuickProject Guides. This chapter guides you through the overall
process of telling a story with video.

Getting Started
We talked in Chapter 4 about framing shots. Wide shots are usually
used to establish context, because they show more information about
where your subject is physically located than close-up shots. Close-ups,
on the other hand, are good for revealing something about your
subject’s character or emotions. Sometimes you need a variety of shots
to tell a story, but sometimes you don’t. If you choose to capture your
whole story in one shot, for example, your editing workload is going to
be pretty light. The videos shown in Figures 5.1 and 5.2 illustrate the
extremes of video editing. Though they’re very different, the story of
each video is clearly defined.
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Figure 5.1 Eric Nelson is a professional
basketball player. In “The Knee Year,” he uses
footage shot over the course of a year to explore
his journey from knee surgery, through rehab, to
playing in a game again. You can find it at
http://bottomunion.com/blog/?p=117

Figure 5.2 “Brooklyn Snow Storm,” at
http://www.scratchvideo.tv/scratch/2006/02/
brooklyn_snow_s.html began as a single
30-minute video shot, which was then speeded
up in editing so that it all elapses in one minute.

The first step of editing is to view your footage and decide which
portions define or shape the story. If you started out with a plan, when
you edit you will arrange your shots according to your notes, script, or



storyboard. Sometimes the story that you shot is not exactly the story
that you planned. Either something completely unexpected happened
or things just didn’t quite turn out the way you thought they would.
This isn’t a bad thing. Editing is a magical process. It’s often the unex-
pected shot that turns out to be the gem of a piece.

Videos for vlogs are generally pretty short, so part of the shaping
process is trimming material you don’t need so your audience sees
just the good stuff. Review your footage with several questions in
mind. Does a particular shot move the story forward or give the audi-
ence important information? If not, you’ll want to set that shot aside.
Are there two shots that tell viewers the same thing? Maybe you can
cut one out to move the story along more quickly. Remember, you’re
not making The Godfather; you don’t have 10 minutes to establish 
the setting, time period, and main characters before getting to the
main story.

As you trim the fat and focus your story, you’ll be selecting and organ-
izing specific shots into a sequence that flows together. This is where
you’ll use wide shots, close-ups, and medium shots to tell your story in
a way that makes sense. All the while, especially if you’re new to
working with video, you’ll notice how things might fit together better
if they’d been shot a little differently. There’s a symbiotic relationship
between shooting and editing. Learning how to edit will make you a
better shooter, and becoming a better shooter will make editing easier.
The really great thing about this process is that you’re constantly
learning and becoming a better storyteller.
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Unlimited Editing Options

Computer-based editing software allows for nonlinear, nondestructive editing.This means
you can position your video clips in any order and rearrange that order at any time, giv-
ing you virtually unlimited editing options. If you’re not happy with the way your video is
turning out, you can easily try another approach.



Figure 5.3
Simplify your
videoblogging by using
one folder for all the
files related to a single
project. If you use a
Mac, put the folder
under Movies to make
it easy to find.
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Preparing Your Footage 
Before you can actually begin editing, you have to import the video
footage from your camera into your computer. You can capture one
long chunk of video and break it down into smaller bits within the
editing application. Or you can view the footage but choose to capture
only those shots you know you want to use. Once the footage has been
imported, you’ll need to collect any other material you’ll want to add
to your video, such as music or still images. But before you do anything
else, it’s a good idea to get organized.

Organizing Your Files
Since video files take up a lot of disc space, it’s important to get organized
before you import footage to your computer. We recommend keeping
all files related to a particular video project together in one folder
(Figures 5.3, 5.4). Once you’ve finished a project, you’ll find a single
folder easy to back up and easy to remove from your hard drive to free
up more space for the next project (See “Backing Up Your Files”).



Figure 5.4
If you use a PC, put
your project folder in
the My Videos folder so
it won’t get lost.
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Backing Up Your Files

The problem with video files is that they’re huge, and while hard drives are getting
cheaper all the time, space doesn’t grow on trees. Sooner or later you’re going to need to
delete finished projects from your drive to make room for new ones.

If you are using a DV camera, your best bet is to keep your original source tapes and don’t
reuse them. Also, exporting a copy of your edited project back to tape is a good idea. This
way you’ll have a pristine copy of all of your hard work.

Obviously, if you are shooting video with a digital still camera, you have to do something
else. Instead of exporting a copy back to tape, you can save a DV version of your edited
project to your hard drive as a file. You can then take that DV file and your original cam-
era clips and burn them to a DVD. This archive DVD won’t play back the way a DVD that
you watch in your living room will. The files will be stored on the DVD in the same format
as on your hard drive. A single-layer data DVD can hold 4.7GB of information, good for
about 20 minutes of DV video. Many new DVD burners use dual-layer discs, which, you
guessed it, store twice as much.

For more information on exporting your project back to tape or as a DV file on your hard
drive, see your editing program’s Help files.

If your computer doesn’t have a DVD burner you might consider purchasing an external
one that connects via FireWire or USB 2.0. A DVD burner will set you back $100 to $150.



Chapter 5: Editing for Vlogs

Importing Video from DV Cameras
To capture DV video from your camera, you will need to connect it to
your computer with a FireWire cable. (Some cameras come with these
cables, but if yours didn’t, you’ll need to buy one separately.) As we
mentioned in Chapter 3, the smaller 4-pin connector plugs into the
port on your camera and the larger, 6-pin connector plugs into a
desktop computer (Figure 5.5). Many Windows-based laptops have
4-pin connectors, so be sure to check first before you buy.

Once you have the cable you need, connect your camera to your
computer. To save yourself some frustration, make sure you turn on
your camera (in VCR mode) before launching your editing software.
Otherwise, the software may not recognize the camera is connected.
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Figure 5.5
The 4-pin FireWire
connector.

When you have everything connected and turned on, it’s time to create
your first video project. If you’re using iMovie, choose DV when the
program prompts you to create a project with a specific video format
(Figure 5.6). If you’re using Windows Movie Maker, the Video Capture
Wizard will walk you through the capture process. Simply select
DV-AVI as the Digital device format when it prompts you for a Video
Setting (Figure 5.7).



Like most other editing programs, both iMovie and Movie Maker have
a capture tool with VCR-like buttons that control your camera
remotely. This allows you to view footage from your camera and cue
the tape to the location where you want to begin capturing. You can
capture one clip at a time or an entire tape. (When deciding how much
to import, keep in mind that about four and a half minutes of DV
footage takes up about 1 GB of hard drive space as a digital file.) 
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Figure 5.6
If you’re using iMovie,
choose DV as the video
format for your project.

Figure 5.7
If you’re using
Windows Moving
Maker, choose Digital
device format (DV-AVI)
when prompted for a
Video Setting.
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As you capture footage, make sure you include a few seconds on either
side of the shots you plan to use in editing. These extra seconds, called
handles, may be needed during editing to create transitions in or out of
shots. Once you finish capturing all the shots for your project, you’ll
see that files called clips have been placed in a bin for you. The bins
used by iMovie and Movie Maker (Figures 5.8 and 5.9) look different
but accomplish the same task by breaking the footage into smaller,
more manageable chunks.
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Figures 5.8 and 5.9 Both iMovie (left) and Movie Maker (right) can place individual clips in a bin as they
import footage.

In traditional film editing, the good takes of a scene were literally cut
out of the film and hooked on a rack that hung over a canvas-covered
bin. Computer-based editing involves a similar task of choosing and
organizing selected clips, and the term bin has been adopted by video
editors.

iMovie Windows Movie Maker



Importing Video from Digital Still Cameras
One day soon importing video from digital still cameras will be a
snap—at least, we hope it will be. Today the process can be a little time
consuming, depending on the video format your camera saves and the
computer and editing application you’re using. But don’t let that scare
you. For many vloggers, the small size and nifty memory cards of these
cameras make up for any video-capture quirks. Keep reading for details.

Importing to a Mac
If you use a Mac, connect your camera, and either the software that
came with your camera or iPhoto will launch. If you are using iPhoto,
click the import button and it will transfer and organize both the
photos and the video clips from your camera. Then all you have to do
is launch iMovie, create a new DV project and just select all the video
clips that you need in iPhoto and drag them to the iMovie project
window (Figure 5.10). No matter whether your camera saves video in,
.mov, .avi, or .mp4, iMovie will convert them all to DV so you can edit
them. The downside is that this conversion process can take a long
time. The good news is that you can go get yourself a sandwich while
this is going on.

Chapter 5: Editing for Vlogs 87

If you’re not using iPhoto, check the camera’s software documentation
for specifics on how and where your files will be transferred.



Chapter 5: Editing for Vlogs

Importing to a PC
When you connect your camera to your PC and turn it on, the software
that came with your camera or the Windows Scanner and Camera
Wizard will launch and provide a way to transfer your clips to your
computer. Please see the camera’s software documentation for
specifics on how and where your files will be transferred. If you’re
using the Wizard be sure to click the Advanced Users Only link
(Figure 5.11) and drag the clips manually to your video project folder,
otherwise the Wizard will skip all of your video files and import only
your photos.
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Figure 5.10
If you use a Mac, you
can drag-and-drop
video clips from iPhoto
to iMovie to edit digital
still camera clips. Just
don’t expect to do it in
a hurry.



With your clips in your video project folder, you are ready to get
started with Movie Maker. If your camera saves clips as .avi files,
you’ve got it easy. You just import the clips directly from your project
folder using the File > Import into Collections command—no
conversion necessary (Figure 5.12).
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Figure 5.11 Clicking the Advanced Users Only link will open up a folder where your clips are stored on your
digital still camera.
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If your camera saves clips as .mp4 or .mov, you need to convert them to
.avi before you can import them. You can download a free program to do
this for you called MP4Cam2AVI Easy Convert at http://sourceforge.net/
projects/mp4cam2avi/. It’s an extra step, but it only takes a few
seconds for each clip.

Once you import your digital still clips into Movie Maker, click the
Collections Button to see all of your clips (Figure 5.13).
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Figure 5.12 Import .avi files into Movie Maker by choosing File > Import into
Collections, or by using the keyboard command (Ctrl+I). Then just choose the videos
you copied to your project folder to import them.



Splitting Your Clips
If the imported footage is in fairly long clips, you’ll need to split them
into shorter clips before you start editing. To do this, choose a clip and
review it. Decide where in the clip you want the next clip to begin. In
iMovie choose Edit > Split Video Clip at Playhead (Figure 5.14). In Movie
Maker choose Clip > Split. Now choose the next clip and do it again.
This will turn your big clips into smaller, discrete clips that you’ll be
able to arrange in any order you want in the timeline.

In some editing applications, the process of identifying the usable part
of a clip is referred to as marking a clip.

As you go through the process of splitting clips, you might be tempted
to delete things you don’t think you’ll use. Instead, set them aside
because there’s a chance they could come in handy (see “Don’t Delete
Potential Gems”).
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Figure 5.13
Clicking the Collections
button allows you to
browse the clips
imported from your
digital still camera.
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Before you start the actual editing, it might be helpful to give your
short clips descriptive names instead of the generic ones assigned by
your editing program. This is especially useful if you’re editing an
interview and all of your clips have nearly identical icons (Figure 5.15).
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Figure 5.15
Give your clips names
that will help you
remember what part of
the story they tell.

thoughts on performing mic didn’t work it all worked
out

Figure 5.14 Splitting a clip follows the same process in both iMovie (shown here) and Windows Movie
Maker.

3. Make the split

1. Select a clip

2. Place the playhead
at the split point



Crafting a Rough Cut
Now that you’ve got all your clips collected and organized, it’s time to
put together a rough cut. A rough cut is just that—a rough assembly of
the shots you want to use sequenced together. You create a rough cut
by dragging each clip into the timeline in the order you want it to
appear (Figure 5.17). Now watch what you’ve created and ask yourself
three questions:

• Is the story all there?

• Does it make sense?

• Are the clips in the best order?
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Don’t Delete Potential Gems

When splitting, renaming, and organizing clips, remember not to delete your extra
footage. At times you’ll need a little something extra to add to a sequence and, odds are
you’ll find it in the leftover footage. In her first video, for example, Michael’s daughter,
Dylan, gives a virtual tour of what it’s like to be her. The video was originally intended to
end after Dylan looked into the camera and said, “This is Dylan...Goodbye!” But just after
she finished the scene, the 11-year-old caught a glimpse of herself in the camera’s
viewscreen. She wrinkled her nose and said,“Aw, I hate my smile” (Figure 5.16). That unex-
pected moment of self-scrutiny turned out to be the real ending of the video and defi-
nitely worth saving!

Figure 5.16
Leftover footage
provided a charming
and unexpected
ending for 11 year-
old Dylan Verdi’s
first video.
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Once your basic sequence is together and the clips are in the right
order, you can start to refine it. This is the stage where you do things
like trim off that unnecessary footage at the beginning or end of each
clip (the handles) or reorder the sequence of clips. This is the real work
of the editing process, and there’s no one way to do it. You can place all
the clips in the sequence you want, then adjust the length of each clip.
Or you can edit an individual clip and refine it, then edit and refine
another clip, and continue to edit and refine as you go. Along the way
you might ask yourself some of the following questions:

• Is the story clear?

• What can I add or take away to make the story clearer? 

• Is this section of video necessary? 

• If I remove this shot, will it help or hurt the story? 

• Is this edit too distracting? What would be better? 

• Where does the sequence drag?
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Figure 5.17
A rough cut consists
of clips without
transitions or effects,
as shown in the Movie
Maker timeline.

If the answer to any question is no, adjust your rough cut until the
answer is yes.



Editing is the process of slowly circling in on your story. You will cut,
watch what you have, make notes about what to change or fix, then do
it all over again. When you’re happy with the order and length of your
clips, you might want to add transitions and titles, and then music and
voice-over to complete your video.

Editing Styles
Understanding the editing process is one thing; developing a personal
editing style is another. Editing style refers to the approach you take to
string your shots together. There are a few different editing styles
vloggers can choose to get started. By familiarizing yourself with
different styles, you have some ready-made approaches to draw from
when you sit down for your first edit. As you continue to create videos
for your vlog, you might decide to mix things up a bit, depending on
your subject matter, your intentions, and your mood.

The Single Take
A single take is simply a video that consists of one continuous shot.
The camera may be stationery or it may move, but it’s still just one
shot. This style is used frequently and quite effectively by vloggers
(Figure 5.18). The major challenge in editing a single take is choosing
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Figure 5.18 Jay Dedman’s “Looking at Things” from the Momentshowing vlog
(www.momentshowing.net/momentshowing/2004/07/videoblog_16_lo.html)
is artfully captured in a single take—including the unexpected ending. Pay
attention to the pace toward the end, which gives viewers time to absorb the
change in setting.
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exactly where to start and end the video. If you’re editing a video that
you planned ahead of time, you’ve probably rehearsed and worked on
the beginning and ending in the shooting process. If, on the other
hand, you’re editing a video of something you just happened to catch
on camera, you’ll probably have a number of choices about where to
make your edits. If you’re not sure where to start or end, ask yourself this
question: What is the shortest section necessary to tell the story? While
you should aim for brevity when editing footage for your vlog, don’t go
overboard—it still should be as long as it needs to be to tell your story.

Using B-roll and Cutaways
Let’s say you’re editing an interview or a shot of someone talking
directly to the camera about gourmet coffee. You can use the shot in its
entirety if it’s the right length and says what you want it to say. But let’s
say you want to cut out the off-camera questions. Do that and you’ll end
up with a jump cut, which gives you a splice between two very similar
but not identical frames. It’s called that because the results can be, well,
jumpy. After the cut, the person on camera may appear to “jump” into a
different position. One way to visually smooth over a jump cut is to
insert a piece of video between the two interview cuts that shows
something else that’s relevant to the story, perhaps a close-up of a
steaming hot cappuccino. This extra footage is referred to as B-roll.

B-roll provides extra visual information that you can use to illustrate
what someone is talking about or to provide an additional detail about
someone or something. When you’re shooting, remember to shoot
some B-roll footage so you’ll have extra material you can use to cut

away from the person
speaking to show a
different piece of video,
while the person’s audio
continues underneath.
These edits are referred to
as cutaways (Figure 5.19).

Secrets of Videoblogging96

Figure 5.19
In Chris Weagel’s “The
Haberek, Pt.2” from the
Human Dog Laboratory
vlog (www.human-
dog.com/lab/?p=180),
B-roll footage was used
for cutaways that give
us insight into the man
being interviewed.



Quick Cuts
Quick cuts let you visually compress the time span of a long sequence
by including just enough brief glimpses of the action for an audience
to follow the story. Let’s say you’ve filmed a woman walking out of her
apartment, waiting for the elevator, riding the elevator down five
floors, people entering the elevator along the way, and finally the
woman exiting the elevator and the building and walking out to the
street. In real time the whole experience took maybe three minutes. If
the footage was intended only as a set up for the story that actually
took place on the street, those three minutes is probably much too
long. Using quick cuts to compress that sequence, you could simply
show the apartment door being pulled closed, the elevator door
opening in the lobby, and your subject stepping out onto the street.
Viewers would still have the facts—that this woman left her apart-
ment and went outside, but they would get them in ten seconds
instead of three minutes. This video entitled “Cut” takes the idea of
quick cuts to the extreme and transforms what could be a pretty
uneventful video of a haircut into a work of art (Figure 5.20).
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Figure 5.20
Tom Laczny’s “Cut,”
from the Fast Moving
Animals vlog
(http://fastmovingani-
mals.blogspot.com/
2006/01/cut.html),
condenses a 15-minute
haircut into a fast-
paced barrage of clips
that clock in at less
than 60 seconds.

Applying Transitions and Effects
Once cutting is complete, you can consider adding transitions and
effects. These are valuable tools in the editing process. Some effects
add a certain style or pizzazz to a sequence, while others help you solve
problems by polishing a rough edge, changing brightness, or making a
two-minute clip play in just a few seconds. Some effects are added to
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the point between two clips, which is called the edit point. Others are
added to an entire clip or group of clips. Let’s take a look at applying
effects to your sequence.

Transition Effects
The purpose of transitions is exactly what the name suggests: to
provide a shift from one shot to another at an edit point. Transitions
can give your videos a little extra spunk, a professional look, or a
smoothing effect. You can also use them to just add fun to a simple
sequence.

There are different types of transitions. The most popular is the cross
dissolve (Figure 5.21). Dissolves blend the end of one image into the
beginning of another and are often used to smooth an edit point that’s
jumpy, jarring, or confusing to viewers. A fade transition, which
dissolves an image in or out of a blank screen (usually black), can
visually imply the passing of time without literally announcing, for
example, “one hour later.” Other types of transitions include wipes,
which use a geometric shape such as a circle to replace one image
with another, or some type of push effect that moves an image off the
screen revealing the next image in the sequence.
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Figure 5.21
In Laczny’s video
“Heat,” long cross
dissolves are used to
fade one image into
another, creating a
separate, third image
in between. Find it on
his vlog at http://
fastmovinganimals.
blogspot.com/2005/
06/heat.html.

Editing applications come with a variety of transitions. You can usually
preview a transition before applying it to make sure it creates the
effect you want (Figures 5.22 and 5.23). Depending on your editing soft-
ware, you may be able to change the speed of a transition to make it a
specific length.
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Figure 5.22 iMovie lets you preview a transition while it’s selected. To apply a transition, in this case a
cross dissolve, drag the transition between any two clips on the timeline (at the bottom of the window).

Figure 5.23 Windows Movie Maker uses two stock images to give you a quick preview of a transition.

Click the
transition for
a preview

Cross Dissolve

Timeline

Speed
slider

Select
a video
transition

Click the play
button for a
preview
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Motion Effects
Motion effects change the speed of your clips by either slowing down or
speeding up the video. Speeding up a clip can condense a long clip into a
much faster “time-lapsed” type of shot. Slowing down a piece of video
can add emphasis or a dramatic effect. Most editing programs have
options for changing a clip’s motion or playback time (Figures 5.24, 5.25).
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Working with Handles

Remember handles, those extra few seconds before and after the primary action you cap-
tured with your clip? Here’s where they come in handy. If you don’t want a transition to
cover important action, add a second onto each end of a clip.Then the transition effect will
go from a handle at the end of one clip into the handle at the beginning of the next so the
main event will be visible in all its glory.

Figure 5.24 In Bottom Union’s video Dance
Dubuffet, http://bottomunion.com/blog/?p=98,
a speedy motion effect is used to give a stop
motion animation feel to a dancer “sliding”
through French artist Dubuffet’s public
sculpture at Hoge Veluwe National Park, The
Netherlands.

Figure 5.25 In 29fragiledays’“Shelter,”
http://29fragiledays.blogspot.com/2005/04/
shelter.html, motion effects are used to slow down
and emphasize a single moment that passed too
quickly for the eye to fully appreciate at regular speed.



Visual Effects
Visual effects can change the overall look of one or more clips. For
example, you can change the style of an image by giving it an “old
movie” look complete with scratches and graininess. You can create an
artsy look by making it black and white or sepia toned, or give it an
action-movie look by shaking it up with an earthquake effect. You can
also use a video effect to correct or improve a clip by adjusting the
brightness or color of the image (Figures 5.26, 5.27).

Depending on the effect, your computer may need a significant span of
time to render it. Rendering is how the computer applies or attaches a
video effect to a clip, and some effects take longer than others to render.
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Figure 5.26 In “Blur” (http://www.
nearlyenough.com/?p=3), posted on Almost
Always Is Nearly Enough, visual effects are used
to manipulate the image into layers of blurred
landscape, creating a very different video than if
the clips were used as they were originally
recorded.

Figure 5.27 In the vlog::banal video “The Belt,”
http:// x.nnon.tv/vlog/2006/01/the_belt.html,
footage from Scratch Video is remixed with
motion effects to create a Cheshire Cat quality
that may not have been intended in the original
video.

Effects are fun, but use them in moderation. Try not to go overboard
with visual effects, which can overwhelm your audience. In most situ-
ations, subtlety is a virtue. If you find that your video truly demands
heavily saturated effects, by all means go for it, but be prepared for
long render and export times.
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Adding Titles
Titles can be used for a variety of purposes in videos. The most obvious
application of titles is at the beginning and end to show the name of
your video and Web address. It’s so easy to copy and post things on the
Internet that videos can end up in several places on the Web. Put a Web
address on any video you create, and people will be able to trace the
origin of your amazing masterpiece and find its creator (Figure 5.28).
Typically, videobloggers add Web addresses to the final three to five
seconds of their videos. Some vloggers create a custom opening
sequence with the name of the videoblog, its URL, and the video’s title
(Figure 5.29).
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Figure 5.28
Jay Dedman ends each
video by showing the
Web address of his
vlog.

Figure 5.29
Sara Weagel opens
every video for Sara’s
Corner (http://human-
dog.com/sara) with a
shot of herself under
the title of her
videoblog.



Titles can also help add context to a story. Who, what, where, when,
why? These questions can be easily and artfully answered with the
help of titles such as those shown in Figures 5.30 and 5.31.
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Figures 5.30 and 5.31 In “The Haberek, Pt.1,” http://www.human-dog.com/lab/?p=163, Chris Weagel uses
simple titles to unobtrusively answer questions about who, where, and when.

Figure 5.32 In “Vaccuming,” Tim Babarini captured amazing footage of
his nephew vacuuming out of boredom. Fortunately for us, Tim used titles to
supplement the roaring audio from the vacuum before he posted the video to
his vlog, Reality Sandwich (http://realitysandwich.typepad.com/blog/2005/07/
vacuuming.html).

Many a vlogger has posted videos with noisy background sound that
makes the recorded speech inaudible. Titles can be a great supplement
to poor audio recordings as well (Figure 5.32).

Titles can also be used to express the thoughts of a videoblogger.
Use them to pose questions or simply add comments along the way
(Figure 5.33).
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Figure 5.33
In “Hey, Let’s Go To
Harris Ranch!,”
http://schlomolog
.blogspot.com/2005/
08/hey-lets-go-to-
harris-ranch.html,
Schlomo of Echoplex
Park allows us to peak
inside his brain and
listen to his innermost
rants.

Figure 5.34 To create a title in iMovie, click on the Title option, type your title, choose your options, and
drag and drop the title onto a clip in your movie. Titles will appear over video unless you select the Over
black box for a black background.

Click to preview

Text field

Title variables

Select for a Black Background

Adding titles to your video is easy. Most applications have a lot of
preset title animations to choose from. Just type your text, pick a font
and size, give it some color, and add it to a sequence (Figures 5.34, 5.35).
Depending on the editing program you use, there may be options for
animating text as well.



Adding and Mixing Sound 
As we’ve mentioned before, sound is as important to a video as
visuals. Music, sound effects, and narration can change the
emotional content of your video. It can create the perfect mood,
add the right finishing touch, or mix intensity with humor to create
a unique perspective. Adding audio files to your project is easy in
both iMovie and Movie Maker. You can simply drag your audio

files to the bin or in iMovie,
use File > Import, or in Movie
Maker, File > Import into
Collection. Then make sure
to switch to the timeline view
to work with audio tracks
(Figure 5.36). After you add indi-
vidual audio tracks, you’ll need
to mix them together to create
a good, balanced sound
(Figure 5.37).
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Figure 5.35
There’s no dragging
and dropping titles
with Windows Movie
Maker. Instead, you
select the location
from a menu.

Figure 5.36
The Show Timeline
button in Movie Maker
does just that—shows
the timeline.
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Creating Voice-Overs
Sometimes the visuals you choose for your vlog can stand alone. But in
some videos, the visuals are not enough. They may need a narration, or
voice-over, to add editorial comment at specific moments (Figure 5.38).

When adding a voice-over to your vlog, a good rule of thumb is to add
extra information with the voice-over instead of simply describing
what’s happening.
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Figure 5.37
The clock button in
iMovie will switch you
to timeline view.

Figure 5.38
In Pouringdown’s
“Theory: Practice,”
http://pouringdown.
blogspot.com/2006/02
/theory-practice.html,
a voice-over provides
insight into the
creator’s thoughts
about his process for
creating videoblogs.

Figure 5.39 Because Macs have a built-in mic,
you can add a voice-over in iMovie by simply
pressing the Record button and talking.

Most editing programs, including iMovie (Figure 5.39) and Movie Maker
(Figure 5.40) have options for recording voice-overs directly into your



sequence. This allows you to record your voice-over while watching the
video, rather than having to sync your audio to your video.

Macs and some Windows laptop have built-in microphones. Desktop
PCs tend not to have built-in mics but makers often include external
mics with their machines. If you have a PC without any mic, or if you
have a Mac but you don’t like the sound from its built-in mic, consider
buying a USB microphone. Logitech (www.logitech.com), for example,
offers a desktop microphone for less than $30.

Adding Music 
Working with music is another magical element of the editing process.
Add the right music to a string of dull images and suddenly they’re full of

life. Music can add depth to a
scene by underscoring the
emotion you’ve captured in
your visuals. It can also add
complexity by adding a
different mood than what the
visuals suggest. You can make
music the main event in your
video by selecting it first and
then editing the visual images
to create your own music
video (Figure 5.41).
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Figure 5.40
You can access the
voice-over tool in
Windows Movie Maker
by clicking the Narrate
Timeline button.

Figure 5.41
In “Highway of Life,”
http://dianasallin
.blogspot.com/2006/
02/highway-of-
life.html, Diana created
a music video by
cutting a collage of
traveling-down-the-
highway images to
illustrate her own song.
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Figure 5.42
iMovie provides a
variety of sound
effects that you can
add to your videos.
Simply drag and drop
the sound effect from
the list to where you
want it in your
Timeline.

If you’re a songwriter or simply like putting tracks together using a
music-creation program, you can use your own music—and only your
own music—however you like (see Chapter 2, “Using Other Material”).
Don’t forget that Creative Commons has links to free music resources
at http://creativecommons.org/audio.

Adding Sound Effects
Sound effects can be a fun element to mix into a soundtrack. But like
visual effects, they can be overused and make your video project
sound like a Saturday morning cartoon (Figure 5.42).



There are plenty of places on the web to find and purchase royalty-free
sound effects. However, licenses for the use of these files might not
always extend to cover their use in your videos on the web. To be free
and clear, we recommend using sites like Ljudo, at http://ljudo.com,
where all the sound effects are Creative Commons licensed (Figure 5.43).
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Figure 5.43
You can search Ljudo
for Creative Commons
licensed sound effects.
These are the results of
a search for “laugh.”

Many videobloggers like to mix sound effects into a soundtrack with a
light hand, adding audio flavor so carefully that the audience isn’t
immediately aware that the soundtrack includes one or more sound
effects. Figure 5.44 offers one example.
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Mixing Audio and Smoothing Cuts 
Now that you’ve added more sound to your video, it’s important to
make sure that your soundtrack transitions smoothly from one cut to
the next, in the same way that your video does. It may be as simple as
fading the audio in at the beginning or out at the end. Other times it
can be more complex.

The story you are telling helps determine your approach to editing the
soundtrack. If your soundtrack includes a conversation, for example,
you can smooth an audio transition by making a cut at a natural pause
in the conversation. This keeps the audio cut from seeming too abrupt
and allows the visuals to keep flowing.

Sometimes cutting from video to a title can sound abrupt and jarring
because the video had ambient sound, or room tone, and the title was
an audio vacuum that had no sound at all. This type of audio jump can
be smoothed over by adding a piece of room tone to the title so that
the soundtrack is continuous. It’s a good idea to record a few seconds
of room tone in each location where you shoot video. If you forget,
don’t panic. After a shoot, there’s nearly always a few seconds of
footage in which no one speaks that you can use as audio filler if
needed.
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Figure 5.44
In Scratch Video’s
“Collection:
QuantumMatter” at
www.scratchvideo.tv/
scratch/2005/10/
collection_quan_1.html,
the sound effects are so
subtle a viewer can
hardly tell what might
be effects and what
might be part of the
video’s original sound.



Pay attention to the visuals in your video and how they interact with
any music you’ve added. For example, be sure to lower your music
tracks when people start talking so viewers can actually hear your
subject speak. It’s fine to keep music underneath an interview, just
make sure the sound levels are balanced. The smoother the audio
sounds, the smoother the video will seem to your audience.

Polishing the Final Version
After you’ve added all the bells and whistles to your video, there’s one
final editing step. Sit back and watch your video straight through. If
you’re feeling brave, get a friend to watch too and give you feedback.
Try to get a feel for the video as a whole. Does it move smoothly? Does
the story make sense? Does it feel too long or too short? At first
viewing, you may feel the video is complete. But watch it repeatedly,
and you may notice a few rough spots that need polishing. You might
notice a jump cut that you didn’t see before or hear snippets of abrupt
sound that need a smoother fade. Take this opportunity to see if every
video element fits together and tie up any loose ends.

If you’ve watched your video 20 times or more over the course of
editing and you’re not sick of it yet, that’s a great sign! Watching
sections of your video, cutting or adding effects to it, and then
watching it again is the repetitive nature of editing and helps you
shape and sculpt your story to perfection.

Get comfortable with editing, because editing is your friend. Every
time you edit a piece for your blog, you learn something that prepares
you for the next time you shoot. You’ll be on the lookout for extra B-
roll, ambient sound, and anything else you might have missed the first
time around.
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